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Managementul proiectelor software 
Laboratorul 4 
 
 

Vizualizări 
 
1. Tipuri de vizualizări 
2. Personalizarea vizualizărilor 
3. Ordonarea şi filtrarea activităţilor 
4. Gantt Chart Wizard 
5. Aplicaţii 
 
 

Un proiect este ca o mică afacere. Ca în orice afacere, persoane diferite participă la diverse 
aspecte legate de obiectul muncii. Secţia de contabilitate se gândeşte în principal, la cheltuielile care 
întreţin afacerea. Supraveghetorul unei fabrici se concentrează asupra termenelor limită şi a 
managerizării resurselor disponibile pentru ca obiectivul sa fie atins. Departamentul tău de Resurse 
Umane se gândeşte la persoane: salariile lor, ore de muncă, beneficii, şi aşa mai departe. 

În calitate de proprietar al unui proiectului, va trebuii să purtaţi toate „pălăriile” (şi mai 
multe) în timpul proiectului. Schimbarea vizualizarilor în MPP este ceva similar cu schimbarea 
pălăriilor.Treci de la o vizualizare  la alta pentru a vedea proiectul tău din alte perspective. Fiecare 
vizualizare vă ajută să vă concentraţi pe un alt aspect al proiectului dumneavoastră. 

Vizualizarile într-un proiect vă permit să intraţi, să organizaţi, şi să examinaţi informaţii în 
diverse moduri. MPP oferă o varietate de vizualizari, şi acest capitol vă ajuta să întelegeti 
elementele de bază in lucrul cu vizualizarile. Următorul capitol acoperă tehnicile de pe care le puteţi 
utiliza pentru a particulariza vizualizarilor. 

 
 
 
1. Ce este o vizualizare? 
 

O vizualizare este o modalitate de a examina proiectul dumneavoastră. Fiecare vizualizare 
vă ajută să vă concentraţi pe un alt aspect al proiectului. MPP utilizează trei tipuri de vizualizari şi 
de obicei, le foloseşte în combinaţii de genul: 

• Chart sau graph views: Prezintă informaţii, prin utilizarea de imagini. Deja aţi văzut 
vizualizarea Gantt Chart, care este un vizualizared de tip Chart. 

• Sheet views: Prezintă informaţii în rânduri şi coloane, similar cu modul în care  
un program de calcul tabelar prezintă informaţii. View-urile de tip Task Sheet şi 
Resource Sheet sunt ambele de tip Sheet views. Fiecare rând de pe foaie, conţine toate 
informaţiile despre o anumita activitate sau o anumită resursă din proiectul 
dumneavoastră. Fiecare coloana reprezinta un câmp care identifică informaţiile stocate 
despre o activitate sau o resursă. 

• Forms: Prezintă informaţii într-un mod în care seamănă cu un formular din hârtie. Ai 
văzut. Aţi vazut Task Form în capitolul 5. Un form afişează informaţii despre un singur 
element (sau activitate) din proiectul dumneavoastră. 

Puteţi modifica view-ul implicit schimbând ce apare pe ecran. Puteţi de asemenea, crea 
vizualizari customizate. Următoarele două secţiuni descriu modurile de a manipula vizualizarile: 

• Schimbând tabela fiecărui view care contine o tabelă. 
• Adăugarea sau schimbarea de detalii care apar în orice view, care conţine o secţiune 

detaliată. 
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1.1. Schimbarea unei tabele 

În cazul în care un view conţine un tabel, se poate utiliza butonul Select All pentru a comuta 
rapid catre un alt tabel. Butonul Select All apare în partea superioară stângă a tabelului dintr-un 
view. Faceţi clic dreapta pe butonul Select All pentru a deschide meniul care apare în Figura 1. 

MPP afişează diferite opţiuni în acest meniu, şi alegerile pe care le vedeţi depind de view-ul 
care este afişat atunci când deschideţi meniul. 

Alegeţi More Tables pentru a deschide caseta More Tables, care afişează toate tabele care 
sunt disponibile în MPP, aşa cum apar în Figura 2. 
 

 
Figura 1. Schimbarea tabelelor prin alegerea din meniul care apare, atunci când 

faceţi clic dreapta pe butonul Select All. 
 
 
 

 
Figura 2. Dialogul More Tables va aratată tabele cu care   

puteţi schimba in Task Usage View. 
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 2. Vizualizări 
 

Următoarea listă prezintă vizualizari implicite care sunt disponibile în MPP: 
• Bar Rollup 
• Calendar 
• Descriptive Network Diagram 
• Detail Gantt 
• Gantt Chart 
• Leveling Gantt 
• Milestone Date Rollup 
• Milestone Rollup 
• Multiple Bases Gantt 
• Network Diagram 
• PA_Expected Gantt 
• PA_Optimistic Gantt 
• PA_PERT Entry Sheet 
• PA_Pessimistic Gantt 
• Relationship Diagram 
• Resource Allocation 
• Resource Form 
• Resource Graph 
• Resource Name Form 
• Resource Sheet 
• Resource Usage 
• Task Details Form 
• Task Entry 
• Task Form 
• Task Name Form 
• Task Sheet 
• Task Usage 
• Tracking Gantt 

 
Iniţial când se deschide fereastra Views, o sa vezeţi numai 24 de vizualizari menţionate. 

Cele patru PERP Views nu apar în fereastră până când nu le folosiţi. După ce sunt utilizate aceste 
vizualizari, care o să apară în fereastra. 

Decizia de a alege una din cele 28 de vizualizari existente (sau unul din vizualizarile 
personalizate) pentru un anumit scop poate fi complicată. Pe măsură ce devii mai familiarat cu 
caracteristicile MPP şi a modul în care aplici conceptele managementului de proiecte, vă veţi 
obişnui cu alegerea vizualizarilor dupa nume. Meniul View şi Bar list-ul sunt cele opt cel mai 
frecvent utilizate vizualizari. Puteţi găsi şi alte vizualizari în fereastra Mai Views. 

Următoarele secţiuni descriu modul în care aceste vizualizari vă permit să vizualizaţi diferite 
aspecte legate de proiectul dumneavoastră. 
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2.1 Detail Gantt 
 
View-ul Detail Gantt afişează o listă de sarcini şi informaţii asociate, precum şi o diagramă 

care afişează timpul şi „slippage” ca bare subţiri între sarcinile, astfel cum este prezentat în Figura 
3.  (Selectaţi View➪More Views). 

 
Figura 3. View-ul Detail Gantt 

 
Bara subţire care se extinde de la marginea stângă a celei de-a treia activitate, arată  timp 

nefolosit dintre al doilea şi al treia activitate. Bara subţire care apare la margine în stângă celei de-a 
doua activitate reprezintă timpul liber între prima sarcină şi cea de-a doua sarcină. Numărul de zile 
apare în ambele cazuri. Puteţi sa va gânditi la timpul nefolosit ca şi cum programul de lucru este 
flexibil. Timpul liber rezultă când iniţial salvaţi nişte sarcini  de probă (fără date exacte)  şi apoi 
înregistraţi datele reale sau durate reale ale sarcinilor, de aceea calculele iniţiale nu coincid de 
obicei cu rezultatele finale. 

Acest view este cel mai util pentru calcularea timpului liber si a celui nefolosit. Tabelul 
implicit al view-ul Gantt este tabela Delay. Utilizaţi tehnicile descrise mai devreme în acest capitol 
în secţiunea „Schimbarea unei tabele”, pentru a modifica tabela. 

Este posibil să doriţi să includeţi Task Details Form view în partea de jos a panoului Detail 
Gantt View, astfel încât să puteţi uita mai atent la activităţi care sunt asociate cu timpului liber si 
timpul nefolosit.  Alegeţi Window ➪ Split, sau utilizaţi split bar-ul pentru a afişa Task Form View-
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ul în panoul de jos. Apoi, alegeţi un câmp de pe Task Form view, View ➪ More Views şi selectaţi 
Task Details Form view. 

 
 
 

 2.2 Leveling Gantt 
 

 View-ul Leveling Gantt, este prezentat în Figura 4 şi se concentrează asupra întârzierilor 
sarcinilor. Acesta vizualizare ne arată o reprezentare grafica a sarcinilor întârziate şi în timp ne 
furnizează si informaţiile detaliate despre sarcini. View-ul deasemenea ne afişeză şi shimbările de 
înainte si dupa rearanjare. Tabelul implicit care apare în view-ul Leveling Gantt este tabela Delay, 
dar aveţi posibilitatea de a modifica tabela, prin utilizarea tehnicilor descrise în secţiunea 
„Schimbarea unei tabele”. Aveţi posibilitatea să utilizaţi tabela Delay pentru a adăuga sau elimina 
întârzieri de timp şi de a se vedea efectele modificările. 
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În această diagramă, puteţi vedea că tema sarcinilor prezintă un nivel de întârziere. Bara din 
stânga a acestei sarcini ne prezintă întârzierea de timp, iar tabelul indică numărul de zile de 
întârziere a sarcinilor. 
 
 
 
 Diagrama Reţea 
 
 Diagrama Reţea e numele vizualizării grafic PERT din Project 98. 
 Project nu produce în fapt un grafic PERT, dar puteţi folosi un add-on – Pert chart Expert. 
  
 Vizualizarea Diagrama reţea, aratata în figura 6-12,  are mai puţin de a face cu sincronizarea 
temporală decât are de a face cu fluxul general de lucru şi cu relaţiile dintre sarcini în proiectul 
vostru. Aceasta vizualizare vă face evaluarea fluxului proiectului vostru şi verificarea dependenţelor 
între sarcini  mai uşoare. 
 
 

 
    Figura 6-12 Vizualizarea Diagrama Reţea. 
 
 Fiecare node în vizualizarea Diagrama reţea reprezintă o activitate în proiectul vostru. 
Pentru Figura 6-13, am folosit comanda Zoom (View->Zoom) pentru a mări un nod astfel încât să îi 
vedeţi detaliile. Un nod contine numele sarcinii, durata, numărul de identificare al sarcinii în 
succesiunea schiţei proiectului, data de start, data de sfârşit, şi , dacă a fost atribuită resursa. 
Grosimea liniei şi culoarea fiecarui nod reprezintă diferite tipuri de sarcini – astfel încât, sarcinile 
critice sunt roşii şi linii groase, în timp ce sarcinile necritice sunt albastre şi cu linii subţiri. puteţi să 
determinati ( şi schimba ) semnificaţia formelor nodurilor în fereastra dialog Box Styles ( alege 
Format->Box Styles ). Liniile care leagă nodurile reprezintă dependenţe. O sarcină care trebuie sa 
urmeze o sarcină terminată, numită activitate succesor,  apare la dreapta sau uneori sub predecesorul 
ei. 



7  
 

 

 
   Figura 6-13: Puteţi vedea detaliile sarcinilor când examinaţi nodurile Diagramei reţea. 
 
 În Project 98 nu puteaţi filtra vizualizarea grafic PERT ; în Project 2000 a fost adăugată 
opţiunea de filtrare. În timp ce vizualizaţi Diagrama reţea, alegeţi Project-> Filtered for şi selectaţi 
filtrul pe care vrei să îl folosiţi. 
 Începand cu Project 2002, puteţi să grupaţi sarcinile în vizualizarea Diagrama reţea; aceasta 
este similar cu modul în care puteţi să grupaţi sarcinile în vizualizarea Gantt. Benzi colorate separă 
nodurile. De exemplu, în Figura 6-14,  vezi sarcinile grupate după durată. Deschideţi meniul Project 
şi apasaţi Group pentru a vedea grupurile care sunt disponibile implicit. Puteţi sa vă creaţi propriile 
grupuri. 
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 Figura 6-14: Puteţi să grupaţi sarcini în diferite moduri în vizualizarea Diagrama reţea. 
 
 Acum puteţi să afişaţi indicatori şi câmpuri personalizate în nodurile Diagramei reţea. 
Adăugaţi informaţia nodului la un şablon de nod existent, sau creaţi un nou şablon. Urmaţi paşii 
următori pentru a afişa indicatorii şi câmpurile personalizate în noduri:  
  

• În vizualizarea Diagrama reţea, alegeti Format-> Box Styles. 
• Apăsaţi pe  butonul More Templates, ca în figura 6-15. 
•  În cutia dialog Data Template , schimbaţi unul din şablonurile existente sau creaţi un şablon 

de la zero.  
• În cutia dialog Data Template Definition, arătată în Figura 6-16 , apăsaţi click în celula unde 

vreţi ca indicatorii sau câmpurile personalizate să apară. Project adaugă un indicator listă de 
cutii celulei, permiţându-vă să deschideţi lista şi să selectaţi informaţia pe care o vreţi în 
aceea celulă a nodului. în figura 6-16, adaug campul Indicators nodurilor. 
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 Figura 6-15: În cutia dialog Box Styles, alegeţi un şablon pe care il vreţi nodurilor din 
diagramă. 
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 Figura 6-16: Adaugaţi informaţii unei celule a nodului Diagrama reţea. 
 

Nota: Nu puteţi să schimbaţi şablonul Standard , dar puteţi să-l copiaţi, ca în Figura 6-15 
•  Apăsaţi click OK pentru a reafişa cutia dialog Data Template. 
• Apăsaţi click Close pentru a reafişa cutia dialog Box Styles. 
• Din lista de şablonuri Data , alegeţi şablonul pe care l-aţi creat sau schimbat. 

Apasaţi click OK. Vedeţi noul câmp în nodurile potrivite. În Figura 6-17, un indicator 
Note 

apare doar  în activitatea Determine budget, deoarece nicio altă activitate în vizualizare nu are 
Observaţii. 

 
 
 Figura 6-17: O Diagrama reţea care afisează indicatori în noduri. 
 
 Vizualizări de analiza PERT 
  
 Analiză PERT este denumita uneori “analiza ce-ar fi dacă”,  şi mulţi manageri de proiect 
folosesc această abordare pentru a estima un rezultat probabil. Rezultatul probabil pe care îl estimaţi 
poate fi durata unei sarcini , data de start a sarcinii, sau data de sfârşit. Ca o funcţie a procesului de 
estimare, specificaţi duratele optimiste, pesimiste şi asteptate ale sarcinilor din proiectul vostru. 
Apoi, Microsoft Project calculeaza o medie ponderată a celor trei durate. 
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 Obervatie: PERT vine de la Program Evaluation and Review Tehnique. Oficiul Proiectelor 
Speciale a Marinei U.S.  a inventat această metodă de a urmări fluxul sarcinilor la sfârşitul anilor 
50. 
 
 Aşa cum probabil aţi ghicit, analiza PERT are puţin de a face cu vizualizarea grafic PERT 
care era disponibilă în Project 98 şi versiunile anterioare.Dar puteţi folosi vizualizările analizei 
PERT  în Project pentru a vă ajuta să estimaţi: 
  

• PA_PERT Entry Sheet 
• PA_Optimistic Gantt 
• PA_Expected Gantt 
• PA_Pesimistic Gantt 

 Puteţi folosi bara de instrumente PERT Analysis, arătată în Figura 6-19 , pentru a realiza 
analiza PERT. Alege View->Toolbars->PERT Analysis pentru a afişa bara de instrumente. 

 
 
 
 Figura 6-19: Folosiţi această bară de instrumente pentru a vă ajuta cu sarcinile de analiză 
PERT. 
 
 Sfat: Aveti nevoie sa folosiţi bara de instrumente Pert Analysis pentru a afisa cele 4 
vizualizări PERT pentru prima data. Dupa ce aţi afişat vizualizările, le puteţi vedea în fereastra 
More Views. 
 
 PERT Entry Sheet 
  
 Vizualizarea PERT Entry Sheet, arătată în Figura 6-20 ,  concentrează  analiza PERT doar 
pe durate. Apasati click pe butonul PERT Entry Sheet în bara de instrumente PERT Analysis pentru 
a afişa această foaie.  
 
 Folosind această foaie, introduceţi duratele optimiste, pesimiste şi aşteptate pentru fiecare 
sarcină. Când apăsaţi pe butonul Calculate PERT în bara de instrumente Pert Analysis, Project 
foloseşte o medie ponderată a numerelor pe care le daţi şi calculează durata probabilă a 
sarcinii.Project arată rezultatul în coloana Duration a respectivei sarcini.Observaţi durata de 1.58 



12  
 

zile pentru activitatea Theme. Project a calculat această durată folosind media ponderata a 
numerelor din colonele Optimistic Dur., Expected Dur., şi Pessimistic Dur. ale sarcinii.      
 
  

 
 Figure 6-20: Folosiţi această vizualizare pentru a vă concentra pe introducerea duratelor 
estimate pentru analiza PERT. 
 
 Optimistic Gantt 
  
 După ce aţi introdus duratele optimiste, pesimiste şi aşteptate în vizualizare PERT Entry 
Sheet , şi aţi apăsat pe butonul Calculate PERT, puteţi vedea rezultatele optimistice pentru întregul 
vostru proiect, în vizualizarea Gantt optimist. Apasă pe butonul Optimistic Gantt din bara de 
instrumente PERT Analysis pentru a afişa vizualizarea Optimistic Gantt. Dupa cum îi zice şi 
numele, vizualizarea Gantt Optimistic , arătată în figura 6-21, este o variaţie a vizualizării Gantt 
Chart; tabelul Optimistic Case este în partea stângă, şi barele Gantt sunt în dreapta. Puteţi să folosiţi 
această vizualizare pentru a introduce şi evalua scenariile optimiste pentru duratele sarcinilor, datele 
de start şi datele de sfarşit. 
 
 Observaţie: Iniţial, veţi putea vedea barele în oricare din vizualizările PERT Gantt. În timp 
ce afisaţi oricare din aceste vizualizări , apasaţi din nou pe butonul Calculate PERT din bara de 
instrumente PERT Analysis şi Project va afişa barele. 
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 Figura 6-21: Folosiţi vizualizarea Optimistic Gantt pentru a analiza duratele saricinilor. 
 Dacă preferaţi să lucraţi cu date de start şi sfârşit, sau să vă concentraţi doar pe duratele 
optimistice când estimaţi, puteţi să folosiţi această vizualizarea pentru a introduce şi evalua 
scenariile optimistice pentru duratele sarcinilor, date de start, date de sfârşit.Dacă folosiţi această 
abordare, trebuie să introduceţi aceleaşi date în  vizualizarea Expected Gantt şi vizualizarea 
Pessimistic Gantt înainte de a da click pe butonul Calculate . 
 
 Expected Gantt   
 
 După ce introduceţi duratele optimiste, aşteptate şi pesimiste în PERT Entry Sheet şi aţi 
apăsat butonul Calculate, puteţi vizualiza rezultatele aşteptate pentru întregul vostru proiect în 
vizualizarea Expected Gantt.Apasă butonul Expected Gantt în bara de instrumente PERT Analysis 
pentru a afişa vizualizarea Expected Gantt, precum este arătat în Figura 6-22. La fel ca şi verişorii ei 
– vizualizările Optimistic şi Pessimistic Gantt- vizualizarea Expected Gantt este o variaţie a 
vizualizării Gantt Chart. Project afişează tabelul Expected Gantt în partea stangă şi barele Gantt în 
partea dreaptă.  
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 Figura 6-22: Folosiţi vizualizarea Expected Gantt pentru a vă ajuta să creaţi duratele 
aşteptate ale sarcinilor. 
 
 Dacă preferaţi să lucraţi cu date de start şi sfârşit, sau să vă concentraţi doar pe duratele 
optimistice când estimaţi, puteţi să folosiţi această vizualizare pentru a introduce şi evalua scenariile 
optimistice pentru duratele sarcinilor, date de start, date de sfarsit.Dacă folosiţi această abordare, 
trebuie să introduceţi aceleaşi date în  vizualizarea Optimisitic Gantt şi vizualizarea Pessimistic 
Gantt înainte de a da click pe butonul Calculate . 
 
 Pessimistic Gantt 
 
 După ce introduceţi duratele optimiste, aşteptate şi pesimiste în PERT Entry Sheet şi aţi 
apăsat butonul Calculate, puteţi vizualiza rezultatele aşteptate pentru întregul vostru proiect în 
vizualizarea Pessimistic Gantt.Apăsaţi butonul Pessimistic Gantt în bara de instrumente PERT 
Analysis pentru a afişa vizualizarea Pessimistic Gantt, precum este arătat în Figura 6-22. La fel ca şi 
verişorii ei – vizualizările Optimistic şi Expected Gantt- vizualizarea Pessimistic Gantt este o 
variaţie a vizualizării Gantt Chart. Project afişează tabelul Pessimistic Gantt în partea stângă şi 
barele Gantt în partea dreaptă. 
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 Figura 6-23: Folosiţi vizualizarea Pessimistic Gantt pentru a vă ajuta să creaţi duratele 
aşteptate ale sarcinilor. 
 
 Dacă preferaţi să lucraţi cu date de start şi sfârşit, sau să vă concentraţi doar pe duratele 
optimistice când estimaţi, puteţi să folosiţi această vizualizarea pentru a introduce şi evalua 
scenariile optimistice pentru duratele sarcinilor, date de start, date de sfârşit.Dacă folosiţi această 
abordare, trebuie să introduceţi aceleaşi date în  vizualizarea Optimisitic Gantt şi vizualizarea 
Expected Gantt  
înainte de a da click pe butonul Calculate . 
 
 
 Ponderile PERT  
 
 Project calculează o medie ponderată când folosiţi analiza PERT. Puteţi să controlaţi 
ponderile pe care le aplică Project fiecărui scenariu din cutia dialog Set PERT Weights, precum este 
arătat în Figura 6-24. Daţi click pe butonul PERT Weights din bara de instrumente PERT Analysis ( 
al doilea buton de la dreapta în bara de instrumente ). Notaţi că valorile pe care le introduceţi 
trebuie adunate să dea 6. 
 Puteţi să folosiţi diferite ponderi pentru a schimba accentuarea pe care Project o aplică la 
calcularea fiecărui scenariu. 
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 Figura 6-25: Folosiţi cutia dialog Set PERT Weights pentru a ajusta ponderile pe care 
Project le aplică când face calcule PERT. 
 
 
Task Form 
 
View-ul Task Form apare în partea de jos a view-ului Task Entry, cum este arătat mai sus in Figura 
6-43. View-ul Task Form, arătat in Figura 6-44, seamană foarte bine cu  view-ul Task Details Form, 
care a fost prezentat anterior in Figura 6-42. 
 
View-ul Task Form furnizează mai multe informaţii asupra resurselor (precum costurile) decât 
vizualizarea Task Details Form, pe când vizualizarea pentru formularul cu detaliile sarcinilor 
furnizeaza mai multe informaţii cu privire la sarcini (cum ar fi predecesorii). Se utilizează butoanele 
Previous si Next pentru a comuta între sarcini. View-ul Task Form deasemenea seamănă foarte bine 
cu vizualizarea Task Name Form. 
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Figura 6-44: View-ul Task Form 

 
Task Name Form 
 
Vizualizarea Task Name Form este apropiat cu vizualizarile Task Details Form si Task Form View. 
Această versiune simplificată arată caracteristicile de baza ale sarcinilor, o activitate la un moment 
dat, dupa cum este arătat in figura 6-45. 
 
Se folosesc butoanele Previous si Next pentru a comuta între sarcini. Din nou, dacă se compară 
Figurile 6-42, 6-44 si 6-45, se poate observa cat de bine seamană aceste vizualizari între ele. View-
ul Task Name Form lucrează foarte bine ca parte intr-o vizualizare combinat. 
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Figura 6-45: View-ul Task Name Form 

 
Folosirea sarcinilor 
 
Aceasta puternica vizualizare, arătat in figura 6-47, permite să se observe cum resursele afectează o 
activitate si arată repartizarea resurselor pentru fiecare sarcină. Se foloseşte acesta vizualizare 
pentru a organiza resursele dupa sarcină, pentru a evalua efortul muncii şi costurile după sarcini, şi 
pentru a compara efortul şi costurile programate cu cele actuale. 
 
Tabela implicită pentru partea din stânga a vizualizarii Task Usage este tabela Usage, dar se pot 
afişa şi alte tabele folosind butonul Table Selection, dupa cum este descris in secţiunea „Schimbarea 
tabelei”, mai sus in acest capitol. Deasemenea, implicit, Project arată Efortul in secţiunea Details 
din partea dreapta. Din nou, se poate selecta orice item din meniul Format Details ori din căsuţa de 
dialog Details Styles (alegeti Format → Detail Styles). 

 
Cum se pot face 12 ore de munca intr-o zi de 8 ore, cum este indicat in proiectul exemplu 
arătat in Figura 6-47? Amintiţi-vă că acesta view arată numarul total de ore ale resurselor: 
dupa cum arată şi figura, doi oameni au lucrat 8, respectiv 4 ore. 
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Figura 6-47: View-ul Task Usage arată resursele grupate in funcţie de  

activitate la care sunt alocate 
 

Folosirea vizualizarilor 
pentru a câştiga în perspectivă 

 
În capitolul 6, au fost exemple de vizualizari gata construite, care vin odată cu Project. Deşi poate 
niciodată nu va fi nevoie de vreun view inafara celor care vin cu Project, nu sunteţi  limitaţi doar la 
aceste vizualizari. Potenţialul de a vedea informaţia din cadrul proiectului este aproape şocantă. În 
acest capitol, vom explora modurile în care putem face vizualizarile să lucreze pentru 
dumneavoastră.  
 
Particularizarea vizualizărilor 
 
Se pot particulariza vizualizarile în Project astfel încât să arate informaţiile necesare. Se lucrează cu 
tabelele in vizualizari care conţin tabele ori cu vizualizarrile înseşi. 
 
 
Schimbarea tabelelor 
În vizualizarile care conţin tabele, se pot face schimbări la fel de simplu precum modificarea 
înaltimii unui rând sau comutarea între două tabele. Sau, se poate modifica stilul implicit în care 
apare tabelul, mutând coloane, ascunzând coloane sau adaugând coloane – şi se salvează 
modificările dumneavoastră într-o nouă tabelă.  
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Modificarea înălţimii unui rând 
 
Această opţiune ajută de fiecare dată când informaţia este prea mare pentru a incăpea într-o celulă. 
Când se modifică înalţimea unui rând, datele se dispun astfel incât să încapă în rândul mai înalt. 

 
Posibilitatea de a schimba înalţimea unui rând este disponibilă doar incepând cu Project 
2000. 
 
 
 

Observaţi că numele sarcinilor la Sarcinile 5 si 7, prezentate in Figura 7-1 nu încap în coloana Task 
Name. Dacă vom creşte înalţimea acestor rânduri, amândouă numele se dispun astfel încât sa fie 
vizibile, după cum este arătat in Figura 7-2. 
 

 
Figura 7-1: Se poate modifica înalţimea unui rând când cursorul mouse-ului  

arată că o săgeată cu două capete 
 

Pentru a modifica înălţimea unui rând, se selectează rândul şi se mută cursorul mouse-ului în 
coloana Task ID Number, în partea de jos a rândului selectat. Cursorul mouse-ului se schimbă într-o 
pereche de săgeti, care arată în sus şi în jos (ca în Figura 7-1). Se trage în jos, şi când se eliberează 
butonul mouse-ului, Project creşte înalţimea rândului şi împarte orice text din acel rând care nu 
incape în lăţimea coloanei. 
 

Pentru a schimba înălţimea a mai mult de un rând, se selectează fiecare rând pe care se 
vrea să se modifice. Se folosesc tehnicile de selecţie Windows. De exemplu, pentru a 
selecta două rânduri neconsecutive, se face click pe ID-ul primului rând, apoi se apasă şi 
se ţine tasta Ctrl, în timp ce se face click pe ID-ul celui de-al doilea rând. Când se modifică 
mai multe rânduri simultan, Project atribuie o înălţime constantă pentru toate rândurile 
selectate.  

 



21  
 

 
Figura 7-2: Când se modifică înalţimea a mai mult de un rând în acelaşi timp, 

Project atribuie aceeaşi înălţime pentru toate rândurile selectate. 
 

Se poate modifica înălţimea unui rând doar de un număr întreg de ori. Cu alte cuvinte, se 
poate mări înălţimea unui rând de două ori faţă de dimensiunea lui iniţială, dar nu de 1,5 
ori. 
 
 
 

 
 
Ascunderea şi inserarea coloanelor 
 
Se poate scoate temporar o coloana dintr-un tabel ascunzând-o. Se face click dreapta pe coloană, şi 
se selectează din meniul care apare Hide Column. Project nu şterge datele din coloana respectivă 
din fişier; în schimb, datele sunt ascunse vizualizării. Pentru a vizualiza din nou coloana (sau pentru 
a adăuga o nouă coloană la tabel), se face click dreapta pe capul coloanei care trebuie sa apară în 
dreapta coloanei pe care o adăugaţi. Apoi, se alege Insert Column din meniul care apare. Se va 
vedea casuţa de dialog Column Definition, aşa cum apare in figura 7-3.  
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Figura 7-3: Se utilizează această căsuţă de dialog pentru a  

adăuga o coloană la tabela  
 

In lista Field name, selectaţi  numele coloanei pe care vreţi sa o adaugaţi. Nu trebuie sa se mai facă 
alte modificări; se apasă butonul Best Fit pentru a fi sigur ca Project alocă destul spaţiu pentru 
numele coloanei. Project inserează coloana in stânga coloanei selectate.  
 
Adăugarea de vizualizări 
 
Se poate selecta un view din bara View, sau se poate alege View→More Views. Project oferă o 
mulţime de alternative pentru vizualizări din care să se selecteze, cum este arătat în figura 7-8. Când 
se creează un nou view, se poate include in bara View sau se poate face disponibil doar în căsuţa de 
dialog More Views. 
 

 
Figura 7-8: O amplă selecţie a vizualizarilor implicite  

intâlneşte mai multe nevoi informaţionale. 
 

Se poate edita un view existent în loc să se creeze unul nou. Dar, ca şi căsuţa de dialog 
More Tables, căsuţa More Views nu are un buton de reset pentru view. În consecinţa, 
orice modificare faceţi este permanentă. Cum s-a sugerat şi mai devreme, se face o copie 
view-ului care trebuie modificat înainte de a modifica view-ul original. În acest mod, view-ul 
original rămâne intact.  
 
Pentru a adăuga un nou view la copia dumneavoastră de Project, se efectuează 

următorii paşi: 
1. Se alege View→More Views. 
2. Se face click pe butonul New în căsuţa de dialog More Views (arătată în Figura 7-8). Va 

apărea căsuţa de dialog  Define New View, ca în Figura 7-9. 
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Figura 7-9: O simplă alegere trebuie făcută în căsuţa de dialog 

Define New View: un view simplu sau combinat. 
 

 
Dacă se poate, noua vizualizare să se bazeze pe o copie a uneia deja existente - vor fi 
mai puţine de făcut pentru a crea vizualizarea. 
 
 

3. Se selectează opţiunea Single view, şi se face click pe OK. Caseta de dialog View Definition se 
deschide, după cum este prezentat în Figura 7.10. 
 

 
Figura 7.10: Se utilizează această casetă de dialog, pentru a numi şi a descrie noua vizualizare. 

 
Dacă se selectează opţiunea Combination view, caseta de dialog View definition  cere informaţii 
puţin diferite. 
 
4. Se introduce numele noii vizualizări în câmpul Name. Se alege un nume care descrie informaţia 
ce va fi arătată în vizualizare. 
5. Se alege o vizualizare curentă pe care să fie bazată noua vizualizare acţionând săgeata pentru a 
descrie lista derulantă Screen. Apoi se alege un nume de vizualizare. 
6. Se execută următorii paşi : 

• Dacă ecranul selectat la pasul 5 oferă opţiunea selectării unui tabel pentru a fi inclus cu el, se 
selectează acel tabel din lista derulantă Table prezentată în Figura 7-11. 

• Dacă ecranul selectat la pasul 5 nu oferă această opţiune, se trece la pasul 7. 
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Figura 7-11: Toate tabelele incluse si tabelele noi care au fost create apar în această listă. 

 
7. Se deschide lista derulantă Filter pentru a alege un filtru ce va fi aplicat vizualizării. Implicit, 
Project aplică filtrul All tasks; de aceea, toate sarcinile apar în vizualizare. Pentru a aplica un filtru 
specific astfel încât proiectul să arate doar sarcinile filtrate, se selectează căsuţa Highlight filter din 
partea de jos a casetei de dialog View definition. 

 
Se pot seta filtre pentru a înlătura sarcinile din vizualizare care nu îndeplinesc 
criteriile de filtrare, sau se pot seta filtre care să evidenţieze sarcinile care 
îndeplinesc criteriile. Pentru reformatarea textului pe care Project îl evidenţiază 
pe măsură ce criteriile de filtrare sunt îndeplinite, se selectează opţiunea 
Format    Text Styles. Mai multe despre aceste tehnici în secţiunea “Filtering 
Views to Gain Perspective,” ce urmează în acest capitol. 

 
8. Se selectează căsuţa Show in menu pentru a face noua vizualizare disponibilă ca opţiune în bara 
de vizualizare şi în meniul View. Dacă nu se bifează această căsuţă, trebuie afişaţă vizualizarea 
selectând-o din caseta de dialog More Views. 
9. Se apasă OK, apoi Apply în caseta de dialog More Views pentru a salva noua vizualizare şi 
pentru a o afişa pe ecran. 
 
Crearea unei vizualizări combinate 
Se pot manipula vizualizările pentru a vedea o configuraţie simplă sau combinată. Vizualizările 
combinate afişează vizualizarea care a fost selectată, la fel ca o a doua vizualizare care include 
informaţii despre activitatea selectată. Figura 7-12 prezintă vizualizarea Network Diagram cu o 
combinaţie de informaţii vizuale şi textuale. 
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Figura 7-12: O vizualizare combinată oferă informaţii pentru sarcinile selectate. 

 
Se poate afişa o combinaţie în orice vizualizare mutând pointer-ul la split bar, ca în Figura 7-13, 
până când cursorul se transformă în două linii orizontale cu săgeţi; apoi se face dublu click. Se 
poate deasemenea face click şi să se tragă bara de separare din partea de sus a ecranului, sau se 
poate alege Window      Split. Există posibilitatea întoarcerii la vizualizarea simplă Network 
Diagram executând dublu click pe bara de separare din nou. 
 
 

Dacă este afişată o vizualizare combinată şi se schimbă vizualizarea, noua 
vizualizare apare deasemenea ca o vizualizare combinată. Pentru a afişa o nouă 
vizualizare care să ocupe tot ecranul, se selectează Window  Remove Split. Se 
poate şti oricând în ce parte din vizualizarea împărţită vă aflaţi din bara active 
view, o linie inchisă care apare de-a lungul marginii din stânga a vizualizării când 
se face click pe vizualizarea de sus sau de jos. 
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Figura 7-13: Când pointerul mouseului apare în această formă, se poate da dublu click pentru a crea o 

vizualizare combinată. 
 
Să presupunem că se doreşte a se crea o vizualizare combinată care să fie afişată oricând. Creaţi o 
vizualizare combinată nouă care include cele două vizualizări pe care doriţi să le vedeţi împreună 
urmaţi aceşti paşi: 
 
1. Se alege View     More Views pentru a se afişa caseta de dialog More Views. 
 
2. Se apasă New pentru a se afişa caseta de dialog Define New View. 
 
3. Se alege opţiunea Combination view pentru a se afişa caseta de dialog prezentată în Figura 7-14. 
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Figura 7-14: În versiunea vizualizării combinate a casetei de dialog View Definition, 

se selectează cele două vizualizări pentru a le plasa pe ecran. 
 
4. Se denumeşte vizualizarea, şi se desemnează ce vizualizare trebuie să apară în partea superioară a 
ecranului şi ce vizualizare să apară în partea inferioară. 
 
5. Pentru a putea afişa vizualizarea selectând-o din meniul View, se bifează căsuţa Show in menu. 
 
6. Se face click OK la sfârşit. 
 

 
Aranjarea sarcinilor intr-o vizualizare 
 
Managementul proiectelor poate fi gândit ca o încercare de a înţelege o slujbă mare împărţită 
progresiv în bucăţi mai mici – până când slujba devinde o colecţie de sarcini. Se doreşte a se 
organizeze sarcinile astfel încât să se poată estima programările, necesarul şi costul. Se pot sorta 
sarcinile şi, începând cu Project 2000, se pot atribui coduri WBS sau numere care să ajute la 
organizarea proiectului. 
 
 
Sortarea sarcinilor 
 
Uneori, sortarea informaţiilor în diferite moduri ajută la observarea lucrurilor care nu ar fi fost 
observate altfel sau chiar pentru o mai bună manipulare pe o problemă. În Project, se poate sorta un 
proiect din mai multe puncte de vedere în aproape orice fel. 
 
De exemplu, în vizualizarea Gantt Chart, Project sortează automat sarcinile după ID (ca în Figura 7-
15). Informaţiile proiectului pot fi vizualizate mai uşor dacă sunt sortate după data de începere (by 
Start Date). Se alege Project     Sort     by Start Date şi Project reordonează diagrama Gantt astfel 
încât sarcinile sunt aranjate după data de începere, după cum se poate observa în Figura 7-16. 
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Figura 7-15 : În mod implicit, Project ordonează diagrama Gantt în ordinea IDului sarcinilor 
 

 
 

Figura 7-16: Folosind comenzi din submeniul Sort, se pot ordona sarcinile după data de început a sarcinii 
(by Task Start Date) 
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Când se alege Project   Sort, se observă cinci chei comune de sortare, cum este prezentat în Figura 
7-17, dar dacă se alege opţiunea Sort by command din partea de jos a submeniului, caseta de 
dialog Sort apare, ca în Figura 7-18. Folosind această casetă de dialog, se pot sorta până la trei 
nivele. Asta deoarece, dacă Project găseşte o ″cravată” la primul nivel, foloseşte cel de-al doilea 
criteriu pentru a rupe legătura.Utilizând casetele de validare din partea de jos a casetei de dialog, se 
pot face permanente opţiunile de sortare prin atribuirea IDurilor de sarcină (Task ID), şi există 
posibilitatea de a alege păstrarea structurii externe a proiectului. 
 

 
Figura 7-17: Se alege unul din aceste cinci criterii comune de sortare direct din meniul Sort. 

 

 
Figura 7-18: Se pot seta mai multe structuri complexe de sortare pe care Project să le folosească în caseta 

de dialog Sort. 
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Crearea codurilor WBS 
Apărarea SUA a dezvoltat iniţial tehnologia de rupere a structurii (Work Breakdown Structure = 
WBS), care se găseşte descrisă în secţiunea 1.6 a MIL-HDBK-881(2 Ianuarie 1998) după cum 
urmează : 

• O familie de arbori orientate spre produs este compusă din hardware, software, servicii, date 
şi facilităţi. Structura arborescentă reiese în urma eforturilor sistemelor inginereşti pe durata 
achiziţiei unui element material de apărare. 

• O diagramă WBS afişează şi defineşte produsul, sau produsele, care urmează să fie 
dezvoltate şi/sau produse. Aceasta se referă la elementele muncii ce urmează a fi realizate 
pentru fiecare produs şi pentru produsul final. 

 
Altfel spus, o diagramă WBS arată o listă de sarcini numerotată care trebuie finalizate pentru a 
termina un proiect. 
 
În Project 2003, încă nu se poate produce o reprezentare grafica a proiectului care este similară cu 
cea prezentată în Figura 7-19. Se pot, însă, atribui coduri WBS pentru fiecare sarcină. Codurile 
WBS pot fi litere şi cifre (sau combinaţii de litere şi cifre) care ajută la identificarea relaţiei dintre 
sarcini şi la organizarea proiectul. 
 

 
Figura 7-19 : Diagrama WBS seamănă cu organigrama unei companii. 
 
 
WBS Chart pentru Project, un produs add-on pentru Project, creează o diagramă 
WBS dintr-un fişier Microsoft Project. CD-ROM-ul care însoţeşte această carte 
include un model al programului. 
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Poate fi folosit orice sistem de numerotare pentru structura codurilor WBS. Să presupunem 
că se atribuie coduri proiectului, similare cu cele prezentate în Figura 7.20. Activitatea numerotată 
1.1.2.3 identifică prima casetă pe nivelul 2, cea de-a doua casetă pe nivelul 3, precum şi cea de-a 
treia casetă pe nivelul 4 al structurii externe  a proiectului. Deşi Project nu produce reprezentarea 
grafică, atribuie numerele pe baza nivelului sarcinii în cadrul proiectului. 
 

 
Figura 7-20: Numerotarea WBS arată relaţia ierarhică a sarcinilor în cadrul proiectului. 

 
Pentru a aloca numere WBS proiectului, se urmăresc aceşti paşi :  

1. Se alege Project      WBS     Define Code. Project afişează caseta de dialog WBS Code 
Definition. Caseta de previzualizare Code arată formatul de cod WBS care va fi creat pe 
măsura conceperii sale - şi, prin urmare, rămâne goală până când se fac selecţii în această 
casetă de dialog. 

2. Se utilizează caseta Project Code Prefix pentru a aplica un prefix tuturor codurilor WBS 
atribuite. De exemplu, se pot folosi iniţialele numelui proiectului. 

3. În coloana Sequence din partea de jos a casetei, se selectează tipul de caracter care va fi 
utilizat pentru fiecare nivel al codului WBS. În Figura 7-21, a fost selectat Numbers 
(ordered), pentru ambele niveluri 1 şi 2, dar se pot, de asemenea, include litere mari 
(Uppercase Letters) sau litere mici (Lowercase Letters). Dacă se alege Characters 
(unordered), Project introduce un asterisc la această poziţie din codul WBS. 
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Figure 7-21: Utilizaţi WBS Code Definition caseta de dialog pentru a  

defini tipul de cod WBS care doriţi să îl utilizaţi. 
 

Dacă alegeţi caracterele (unordered) din coloana Sequence, 
puteţi introduce orice caractere doriţi în acea parte a codului WBS. 
De exemplu, să presupunem că folosiţi o mască de numere (ordered) 
lungime 1, numere (ordered) lungime 1, caractere (unordered) 
lungime 3. Pentru orice  activitate de nivel 3, puteţi introduce orice 3 

caractere pe care le doriţi in a treia parte a codului WBS. În acest 
exemplu cănd introduceţi o activitate de de nivel 3 iniţial o sa vezi un 
WBS de forma 1.1.***. Oricum il poţi schimba in ceva de genul acesta 
1.1.a#3. 

 
4. Deschideţi caseta in coloana Length si alegeţi lungimea pentru nivelul codului WBS. În 

figura 7-21 am setat nivelul 1 la 2 cifre, dar am permis orice numar de 2 cifre pentru nivelul 
2. Poţi alge Any, slectat din lista predefinată de numere de la 1 la 10, sau introdu orice 
număr. 

 
 
Din curizitate tenică am testat numarul 100, si proientul a fost 

acceptat, dar  folosind un numar de 100 de cifre in codul WBS nu 
este foarte practice. 
 

5. În coloana Separator utilizaţi caseta listă pentru a selecta  punct (.), linie (-), plus (+), sau 
separator (/), sau introdu orice character care nu este un numar sau o litera. 

6. Repeta pasul anterior pentru fiecare nivel pe care vrei să îl defineşti. 
7. Apasă OK cand termini. 

 
Ar trebui, probabil, să selectaţi casetele de selectare din 

partea de jos a definiţiei codului WBS, deoarece asigură că toate 
sarcinile sunt asignate codului WBS si că taote codurile sunt unice. 

 
 

Codurile WBS nu apar in mod implicit in modul de 
vizualizare Gantt Chart, pentru a vedea codurile WBS  trebuie sa adugi colona WBS. 
Pentru a adăuga coloana WBS la stânga coloane Task Name faceţi clic dreapta pe 
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coloana  Task Name. Proiectul selectează coloana si afişează un meniu de  comenzi 
rapide. Alegeteţi Insert Column  din meniul de comenzi rapide şi priectul afişază caseta   
de dialog  Column  Definition.         Deschide caseta de dialog Field Name si selectează 
WBS. Dacă vreţi puteţi modifica alinierea datelor la stânga. Apoi faceţi clic pe Best Fit 
pentru a adăuga coloana pe porţiunea din vederea Gantt Chart după cum se vede in figura 
7-22 

 

 
Figure 7-22: Când afişaţi coloana WBS, proiectul afişează 

codurile WBS pentru fiecare sarcină din proiect 
 
 
 

 
 

Dacă aţi fi adăugat coloana WBS înainte de a define codurile  WBS 
ar trebui să  fi vazut schema de numerotare care corspunde cu poziţionarea 
sarcinilor în proiect. 

 
 
Renumerotarea codurilor WBS 
 
Codurile WBS nu se renumerotează automat singure in toate cazurile cand schimbi 

structura proiectului aşa cum este în figura 7-23. Codurile WBS fac in mod automat 
renumerotarea dacă schimbaţi nivelul sarcinii în structura proiectului. Aceasta este, dacă 
trageţi o sarcină de nivel 1 la o nouă locaţie de nivel 1 sau dacă tragi o subsarcină către  o 
nouă locaţie sub activitate originală ambele sarcini reţin codul original WBS. Cu toate 
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acestea, dacă promovează sau retrogradează activitate, sau dacă muţi  astfel încât 
acestea să apră la un alt nivel  în schema, proiectul atribuie sarcinii un nou cod WBS. 
Puteti testa premisa trăgând Request Purchase Order  astfel încât aceasta să apră 
înaintea Order Food. Fiecare sarcină reţine coudul WBS original, şi proiectul atribuie un 
nou cod WBS — AM-08 — pentru Request Purchase Order. 
 

 
Figure 7-23: Pentru ca am mutat sarcinile,codurile WBS nu mai sunt secventiale. 
 
 
  

Dacă lucrezi la un contract guvernamental pentru care tu şi 
guvernul aţi fost de acord la un sistem de numerotre si nu vrei ca 
codurile WBS să se schimbe chiar dacă muti sarcinile imprejur, 
foloseste codurile Outline,care sunt statice. Poţi atribui în acelasi 
timp codul Outline si codul WBS la o sarcină.(Vei citi despre codurile 
Outline mai târziu în acest capitol.) 

 
 

 
 Uneori, veţi dori să renumerotaţi codurile WBS, chiar dacă proiectul nu le 
renumerotează în mod automat. – şi se poate. De fapt poţi renumerota întregulproiect sau 
porţiuni selectate din proiect. Dacă alegi să renumerotezi porţiuni selectate, trebuie 
selectata sacina înainte de a începe precesul de renumerotare. 
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Nu poţi anula renumarotarea codurilor WBS , aşa că salvaţivă proiectul  înainte de 
a începe această operaţiune. În acest fel dacă nu îţi place rezultatul poţi închide proiectul 
făra a salva şi să îl redeschizi după în stadiul în care l-ai renumeroat înainte.  
 
 

Pentru a renumerota toate sarcinile din proiect  urmeaza următorii paşi: 
 
1. Alege Project   WBS  Renumber. Proiectul afişează o casetă de dialog ca in 

figura Figure 7-24. 
 
 

 
Figure 7-24: Foloseşte aceasta caseta de dialog pentru a 

renumerota sarcinile din proiect 
 
 

2. Clic OK. Proiectul vă solicită înainte de renumerotarte. 
3. Clic Yes. Proiectul redistribie toate numerele WBS aşa cum arată in  

figura 7-25. 
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Figure 7-25: Codurile WBS sunt secventiale dupa renumerotare. 

 
 

În acest moment voi ascunde coloana WBS pentru a menţine un ecran cât se poate 
mai curat. 
 
 
Filtrarea vizualizărilor pentru a obţine perspectiva 
 
 
 Filtrele vă ajută să vă concentraţi pe anumite aspecte ale proiectului. De exemplu, 
să presupunem că vreţi sa vizualizaţi sarcinile care sunt atribuite unei anumite resurse sau 
vrei să afişezi numai sarcinile care sunt pe cale critică pentru proiectul dumneavostră. 
Puteţi aplica filtre pentru a limita informaţia pe care o vedeţi si pentru a vă ajuta să vă 
concentra pe o anumită problemă. 
 Filtrle proiectului vin în două varietăţi: sarcinile filtru, care vă permit să vedeţi 
anumite aspecte ale sarcinii, şi filtrele resursă care vă permit sa vedeţi anumite aspecte 
ale unei resurse. În tabelul 7-1, vei găsi o descriere a default task filters , şi in tabelul 7-2, 
vei găsi o descriere a default resource filters. Multe din filtre execută funcţii similare. 
 

 
Sarcinile cu filtre limită(Deadlines filter) şi cele cu durata 

estimtă(Estimated Durations filter) au apraut prima dată în Project 2000. 
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Aplicarea unui filtru la o vizualizare 
 
Prin aplicarea unui filtru la o vedere, vei specifica criteriile care proiectul utilizează 

să determine care sarcină ar trebui să apară în acea vedere. Proiectul selectează 
informaţia pentru a o afişa sau o va ascunde restul de informaţiei. Pentru a aplica un filtru 
şi de a ascunde toate celelalte informaţii urmează următorii paşi:  

1. Afişează vederea pe care vrei să o filtrezi. 
2. Alege Project  Filtered 
3. Alege filtrul pe care îl doreşti din meniul Filtered. 

 
Deoarece Project îţi permite să aplici filtre sarcină numai 

pentru vizulizarea sarcinilor şi filtre resursă numai  pentru 
vizualizarea resurselor, Filtered  meniul ierarhic arată fie toate 
sarcinile fie toate resursele, în funcţie de punctul de vedere pe 
care la-ţi afişat înainte de a începe paşii. 

 
 Pentru a aplica un filtru care nu se află în lista, sau de a aplica un filtru subliniind 
urmaţi următorii paşi: 
 

1. Afişaţi vederea pe care vreţi să o filtraţi. 
2. Alege Project Filtered for  More Filters. Project afişează caseta de dialog 

More Filters aşa cum arată în figura 7-30. 
 

 
Figure 7-30: Foloseşte caseta de dialog More Filters 

pentru a aplica filtre care nu apar in lista Filtered 
3. Faceţi clic pe butonul Task Option pentru a selecta si a aplica filtrul sarcină, 

selectează butonul Resource Option   pentru a aplica un filtru resursă. 
 
 
 
Reţine că Project nu te lasă să aplici un filtru sarcină pe o vedere resursă 
sau invers. 
 
 

4. Selectează numele filtrului din lista. 
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5. Faceţi clic pe Apply pentru a aplica filtrul sau clic Highlight pentru a aplica filtrul 
de evidenţiere. Dacă filtrul pe care doreşti să îl aplici este un filtru interactiv 
scrieţi valorile cerute. 

6. Faceţi clic pe butonul OK. 
 
 
 
Folosirea filtrelor automate (AutoFilters) 
 Filtrele automate sunt similare cu cele regulate ale Project, dar le puteţi accesa 
direct de pe foaie din orice foaie de vedere în loc de a folosi un meniu sau o fereastră. În 
mod implicit  opţiunea AutoFilters este dezactivată când creaţi proiectul dar îl puteţi activa 
făcând clic pe butonul AutoFilters din bara de opţiuni Formatting. 
 Când activaţi AutoFilters apare o casetă săgeată la marginea dreaptă  a fiecarei 
coloane. Când deschizi lista derulantă  Project afişează  filtrele care sunt adecvate pentru 
coloana respectivţ aşa cum arată în figura 7-32. 
 
 

 
Figure 7-32 

 
 

Puteţi activa automat AutoFilters pentru noi proiecte pe care le 
creaţi. Alege Tools Options si faceţi clic pe tabul General. Slectaţi Set 
AutoFilter On pentru proiectele noi. 
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Folosirea grupărilor 
  
Gruparea este o altă tehnică pe care o puteţi utiliza pentru a vizualiza informţii 

despre proiectul dumneavoastră. Este posibil să rezolvi problema dacă grupezi sarcinile 
după un numitor comun. În figura 7-33, am gupat sarcinile după durata lor pentru a 
identifica durata cea mai scurtă. 
 

 
Figure 7-33:  Gruparea sarcinilor intr-o vedere pentru a te ajuta identifica informatii despre proiectul 

dumneavoastră 
 
 Project conţine unele grupuri predefinite. Pentru a folosi unul din aceste grupuri 
pentru a organiza sarcinile într-o vedere grupând după un numitor comun urmaţi paşii 
următori: 

1. Afişează în vedere faptul că doriţi să folosiţi gurparea sarcinilor. 
2. Alege Project Group By, sau foloseşte Group By din bara de optiuni standard. 
3. Alege guparea pe care o doreşti din meniul Group By 

 
 
Deoarece Project îţi permite să gupezi sarcinile numai în task 

view şi resursele în resource view , meniul Group By arată ori 
gruparea sarcinilor ori gruparea resurselor, depinzând de vederea 
pe care o afişezi atunci când porneşti acesşti paşi. 
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VIII. Gantt Chart Wizard 
  
 Puteţi face modificări unor elemente specifice în diverse proiecte. Cu toate 

acestea Gantt Chart are propriul său ajutor expert pentru a vă ajuta formata anumte bucaţi 
din proiect.Rularea prin intermediul Gantt Chart pune în evidenţă ceva opţiuni.   

 
Un wizard este o serie interactivă de casete  de dialog care vă cer să 
răspundeţi la întrebări sau să faceţi selecţii. Project utilizează datele 
introduse de dumneavoastră pentru a modifica anumite aspecte ale 
proiectului.  
 

 Aveţi posibilitatea de a utiliza Gantt Chart wizard fie din Gantt Chart View fie din 
Tracking Gantt Chart. Deoarece  schimbarile Gantt Chart wizard se aplică numai fişierului 
deschis atunci cand rulezi wizard-ul, începând prin afişarea proiectului pe care vrei să îş 
formatezi. Apoi urmaţi aceşti paşi pentru rularea Gantt Chart Wizard . 

 
Nu există buton de a anula schimbarile efectuate de Gantt Chart 

Wizard. Pentru a evita aceasta salvează proiectul înainte de a aplica Gantt 
Chart Wizard. Dacă nu îţi convine rezultatul închide proiectul făra a salva 
apoi redeschidel. 
 
 

1. Faceţi clic pe butonul Gantt Chart Wizard din bara de formatare sau alege 
Format Gantt Chart Wizard pentru  a porni wizard-ul. O casetă de dialog va 
apărea ca în figura 8-1 

 
 

 
Figure 8-1: Pasul 1 

 
 

 
Cele 4 butoane din partea de jos a casetei de dialog apar in fiecare 
casetă de dialog din Wizard. Faceţi clic pe Cancel pentre a părasi 
asistentul făra a salva setările, clic pe Back pentru a reveni cu un pas in 
urma, clic pe Finish pentru a termina Wizard-ul cu datele introduse până 
în acel punct. 
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2. Faceţi clic pe Next pentru a trece la pasul 2. În cea de-a doua caseta de dialog ,aşa 

cum se arată in figura 8-2, se indică categoria de infoarmaţii pe care doriţi să le 
afişaţi. Puteţi selecta doar un singur post. Încercaţi sa faceţi clic pe fiecare din 
urmatoarele alegeri pentru a vedea previzualizarea stilului. 
• Standard – afişează un taskbar albastru, negru pentru taskbar-ul rezumat şi o 

linie neagră suprapusă peste taskbar care indica progresul sarcinilor. 
• Critical Path – este aşezarea Standard, cu calea critica in roşu.  
• Baseline – după cum arată în figura 8-2. 
• Other – afişează o listă care conţine câteva alternative predefinite pentru 

urmatoarele categorii Standard,Critical Path,BaseLine si Status. 
• Custom Gantt Chart – afisează mai multe ecrane suplimentare pentru a vă 

permite crearea unui Gantt Chart personalizat. 
 

Evidenţierea sarcinilor critice într-un proiect vă ajută sa acordaţi mai multă 
atenţie atunci când revizuiţi sau când urmăriţi progresul. Dacă nu doriţi să 
formataţi Gantt Chart pentru a trata diferit sarcinile critice,încercaţi să 
folosiţi un filtru pentru a afişa temporar doar sarcinile critice aşa cum am 
discutat în capitolul 7. 
 
 

 

 
Figure 8-2: Previzualizare  oferă o idée cam cum ar arăta fiecare opţiune de formatare 
 

3. Faceţi clic pe butonul Next pentru următorul pas. În această casetă de dialog poţi 
alege tipul de informaţie care sa apară cu barele Gantt. Resusele si termenele 
limită,...etc. 
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Aplicaţii 
 

1. Vizualizaţi proiectul StrategicPlan.mpp sub forma diagramei PERT (“Network Diagram”). 
 
2. Activaţi bara de instrumente “PERT Analysis” şi modificaţi informaţiile despre durata 
activităţilor, utilizând “PERT Entry Sheet”. Durata optimistă va fi 50%-80% din durata introdusă, 
durata aşteptată va fi 90%-110%, iar durata pesimistă va fi 120%-150%. Afişaţi diagramele Gantt 
corespunzătoare celor 3 situaţii. 
 
3. Creaţi o vizualizare combinată în care fereastra de sus permite editarea activităţilor, iar fereastra 
de jos permite editarea resurselor necesare pentru aceste activităţi. 
 
4. Creaţi coduri WBS pentru activităţile proiectului şi inseraţi coloana corespunzătoare în tabelul 
activităţilor. 
 
5. Utilizaţi “Gantt Chart Wizard” pentru a marca drumul critic al proiectului şi filtraţi afişarea 
pentru a include doar activităţile de pe drumul critic. 
 
6. Grupaţi activităţile după apartenenţa la drumul critic şi apoi după durată. 

 


